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Copyrights

Copyrights

© Cypress Semiconductor Corporation, 2015. The information contained herein is subject to change without notice.
Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied
in a Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not
warranted nor intended to be used for medical, life support, life saving, critical control or safety applications, unless
pursuant to an express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as
critical components in life-support systems where a malfunction or failure may reasonably be expected to result in
significant injury to the user. The inclusion of Cypress products in life-support systems application implies that the
manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.

Trademarks

PSoC is a registered trademark and PSoC Creator and F-RAM are trademarks of Cypress Semiconductor Corp. All other
trademarks or registered trademarks referenced herein are property of the respective corporations.

Source Code

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is
protected by and subject to worldwide patent protection (United States and foreign), United States copyright laws and
international treaty provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to
copy, use, modify, create derivative works of, and compile the Cypress Source Code and derivative works for the sole
purpose of creating custom software and or firmware in support of licensee product to be used only in conjunction with a
Cypress integrated circuit as specified in the applicable agreement. Any reproduction, modification, translation,
compilation, or representation of this Source Code except as specified above is prohibited without the express written
permission of Cypress.

Disclaimer

CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATERIAL,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described
herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described
herein. Cypress does not authorize its products for use as critical components in life-support systems where a
malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’
product in a life-support systems application implies that the manufacturer assumes all risk of such use and in doing so
indemnifies Cypress against all charges.

Use may be limited by and subject to the applicable Cypress software license agreement.
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Regulatory Compliance

The CY15FRAMKIT-001 Serial F-RAM™ Development Kit is intended for use as a serial memory development platform
for hardware or software in a laboratory environment. The board is an open-system design, which does not include a
shielded enclosure. Therefore, the board may cause interference with other electrical or electronic devices in close
proximity.

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its
performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected,
suitable mitigating measures should be taken.

The CY15FRAMKIT-001, as shipped from the factory, has been verified to meet with the requirements of CE as a
Class A product.

€

The CY15FRAMKIT-001 contains ESD-sensitive devices. Electrostatic charges readily accumulate
on the human body and any equipment, and can discharge without detection. Permanent damage
‘ may occur to devices subjected to high-energy discharges. Proper ESD precautions are
recommended to avoid performance degradation or loss of functionality. Store unused

‘@ \ CY15FRAMKIT-001 boards in the protective shipping package.

End-of-Life/Product Recycling

The end-of-life cycle for this kit is five years from the date of manufacture mentioned on the back of
the box. Contact your nearest recycler to discard the Kkit.
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General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform procedures only at
an ESD workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist
strap attached to the chassis ground (any unpainted metal surface) on the board when handling parts.

Handling Boards

CY15FRAMKIT-001 boards are sensitive to ESD. Hold the board only by its edges. After removing the board from its
box, place it on a grounded, static-free surface. Use a conductive foam pad if available. Do not slide the board over any
surface.
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Thanks for your interest in the CY15FRAMKIT-001 Serial F-RAM Development Kit (DVK). The kit (shield) is designed as
an easy-to-use and inexpensive development kit, showcasing the features of Cypress serial ferroelectric random access
memory (F-RAM). Designed for flexibility, this kit offers footprint-compatibility with CY8CKIT-042 PSoC® 4 Pioneer Kit,
CYB8CKIT-040, CY8CKIT-042 BLE, third-party Arduino™ UNO R3, and several other Arduino kits. This board features a
256-Kbit SPI F-RAM, a 256-Kbit I°C F-RAM, three-pole DIP switch to control the I°C F-RAM device select pins, Arduino
UNO compatible headers, and two debug headers. This kit supports power supply voltages of either 5.0 V or 3.3 V.

The CY15FRAMKIT-001 is a development kit for the Cypress Serial F-RAM memories. Cypress F-RAM is built on
ferroelectric technology, which combines the nonvolatile data storage with the high-performance RAM. Serial F-RAMs
provide fast writes at full bus speed. They do not have any write delays and data is instantly nonvolatile. They consume
as low as 300 pA active and 6 pA standby current. Because of fast write speeds, serial F-RAMs need to be active for

short periods, yielding very low energy consumption. Endurance is virtually unlimited offering 100 trillion read/write
cycles.

1.1 Kit Contents

The CY15FRAMKIT-001 Serial F-RAM DVK includes the following contents, as shown in Figure 1-1:
®  CY15FRAMKIT-001 serial F-RAM DVK board
B Quick start guide

Figure 1-1. CY15FRAMKIT-001 Serial F-RAM DVK Contents

Visit www.cypress.com/shop for more information. Inspect the contents of the kit; if any parts are missing, contact your
nearest Cypress sales office for help.
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1.2 PSoC Creator™

PSoC Creator is a state-of-the-art, easy-to-use integrated design environment (IDE). It introduces revolutionary hardware
and software codesign, powered by a library of preverified and precharacterized PSoC Components™.

With PSoC Creator, you can:

®  Drag and drop PSoC Components to build a schematic of your custom design
B Automatically place and route components and configure GP1Os

®  Develop and debug firmware using the included component APIs

PSoC Creator also enables you to tap into an entire tools ecosystem with integrated compiler chains and production
programmers for PSoC devices. For more information, visit www.cypress.com/Creator.

1.3 Getting Started

This guide helps you to get acquainted with the Serial F-RAM DVK. The Kit Installation chapter describes the installation
of the kit software. The Kit Overview chapter explains the features of the kit. The Hardware chapter details the hardware
operation. The Examples Projects chapter describes the code examples. The Appendix provides the schematics, pin
assignment, use of zero-ohm and 30-ohm resistors, and the bill of materials (BOM).

1.4 Additional Learning Resources

Visit www.cypress.com/go/F-RAM for additional learning resources in the form of datasheets and application notes. The
baseboard-related resources are available in the following links.

B CYB8CKIT-042 PSoC 4 Pioneer Kit
®  Arduino UNO R3

1.5 Technical Support

For assistance, go to our support web page, www.cypress.com/support, or contact our customer support at
+1 (800) 541-4736 Ext. 2 (in the USA) or +1 (408) 943-2600 Ext. 2 (International).

1.6 Documentation Conventions

Table 1-1. Document Conventions for Guides

Convention Usage

Courier New Displays file locations, user-entered text, and source code:
C:\...cd\icc\

ltalics Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold] Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]
File > Open Represents menu paths:
File > Open > New Project
Bold Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.
Times New Roman Displays an equation:
2+2=4
Text in gray boxes Describes cautions or unique functionality of the product.
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This section describes the installation of the CY15FRAMKIT-001 Serial F-RAM DVK software and prerequisites.

2.1 Prerequisite Software

You must install the PSoC Creator IDE or the Arduino IDE before using the kit. All Cypress software installations require
administrator privileges. Administrator privileges are not required to execute the software after installation. Close all other
Cypress software that is currently running before you install the kit software.

To download the PSoC Creator IDE, go to www.cypress.com/psoccreator.

To download the Arduino IDE, go to arduino.cc/en/Main/Software.

2.2 Install Kit Software

Follow these steps to install the CY15FRAMKIT-001 Serial F-RAM DVK software:

1. Download the CY15FRAMKIT-001 DVK software from www.cypress.com/go/CY15FRAMKIT-001. The
CY15FRAMKIT-001 software is available in three different formats (see Figure 2-1):

Figure 2-1. Available Formats for Downloading Serial F-RAM DVK Software

(a) [ cY15FRAMKIT-001 Kit Setup (Kit Design Files, Documentation, English
Examples) B3
(b) | 2 cvisFramMKIT-001 cD iSO B English

e CY15FRAMKIT-001 Kit Setup: This executable file installs only the kit contents, which include kit code
examples, hardware files, and user documents.

e CY15FRAMKIT-001 CD ISO: This file is a complete package, stored in a CD-ROM image format, which you can
use to create a CD or extract using ISO extraction programs, such as WinZip or WinRAR. The file can also be
mounted like a virtual CD using virtual drive programs such as Virtual CloneDrive and MagiclSO. This file
includes all the required firmware, hardware files, and user documents.

2. If you have downloaded the CD ISO file, mount it on a virtual drive. Extract the 1ISO contents if you do not have a
virtual drive on which to mount. Double-click cyautorun.exe in the root directory of the extracted content or mounted
ISO if “Autorun from CD/DVD” is not enabled on the PC. The installation window shown in Figure 2-2 will appear
automatically.

Note: If you are using the Kit Setup file, then go to step 3 for installation.

3. The kit startup screen appears as shown in Figure 2-2. The default installation location is Cypress under Program
Files folder.

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *A 9
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Figure 2-2. Kit Installer Startup Screen

CY15FRAMKIT-001 Serial F-RAM Kit - InstallShield Wizard

Welcome to the InstallShield Whizard for
CY15FRAMEIT-001 Sernal F-RAM Kit

The InzstallShield wizard will install v SFRARMEIT -001
Serial F-RAM Kit on your computer. To continue, click
Meut.

Select folder where setup will install files.

G Install Cv15FRAMEIT-001 Senial

C:A ACypress

< Back [ Mext = ][ Cancel

Select the folder in which you want to install the CY15FRAMKIT-001 kit-related files. Choose the directory and click
Next.

Select the Typical installation type in the Product Installation Overview window, as shown in Figure 2-3. Click
Next.

Figure 2-3. Product Installation Overview Window

% Cylnstaller for CYISFRAMKIT-001 Serial F-RAM Kit )

Product Installation Overview
Choose the install type that best suits your needs

Choose the type of installation

Product:
CY15FRAMKIT-001 Serial F-RAM Kit

Installation Type:

Installs the most common features of
CY15FRAMKIT-001 Serial F-RAM Kit.

([Comoa ] (o> ] [ Cone ]

When the installation begins, a list of packages appears on the installation page. A green check mark appears next
to each package after successful installation.

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *A 10
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If this is the first Cypress product that you have installed, enter your contact information or select the option
Continue without Contact Information. Click Finish to complete the CY15FRAMKIT-001 kit installation.

After the installation is complete, the kit contents are available at <Install Directory>\CY15FRAMKIT-001
Serial F-RAM Kit\1.0. The default locations are as follows:

Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY15FRAMKIT-001 Serial F-RAM Kit\1.0
Windows 7 (32-bit): C: \Program Files\Cypress\CY15FRAMKIT-001 Serial F-RAM Kit\1.0

Note: For Windows 7/8/8.1 users, the installed files and the folder are read-only. To change the property, right-click
the folder and choose Properties > Attributes and then disable the Read-only option. Click Apply and OK to close
the window.

After the installation is complete, the following are installed on your computer:

Kit documents

e Quick start guide

e Kit guide

e Release note

Firmware

e PSoC 4 F-RAM SPI example project

e PSoC 4 F-RAM I2C example project

e Arduino UNO F-RAM SPI example project
e Arduino UNO F-RAM I2C example project
Hardware

e Schematic

e Layout

e Gerber

¢ PCB assembly drawing

e Bill of materials (BOM)

2.3 Uninstall Software

The software can be uninstalled using one of the following methods:

Go to Start > Control Panel > Programs and Features; select the appropriate software package and click
Uninstall.

Go to Start > All Programs > Cypress > Cypress Update Manager > Cypress Update Manager.

e Select the “CY15FRAMKIT-001 Serial F-RAM Kit 1.0 Rev **” row and click Uninstall. In the Product
Installation Overview window, select Remove from the Installation Type drop-down menu. Follow the
instructions to uninstall.

Note: This method will uninstall only the kit software and not all the other software that may have been installed
along with the kit software.

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *A 11
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3.1 CY15FRAMKIT-001 Serial F-RAM Development Kit Overview

The CY15FRAMKIT-001 Serial F-RAM DVK can be used to understand the features of the serial F-RAMs (SPI and | C)

The DVK is a shield board, which contains the 256-Kbit SPI F-RAM and 256-Kbit 1°C F-RAM. It has four connectors that
are Arduino UNO-compatible and connect to either Cypress PSoC 4 Pioneer Kit or Arduino UNO R3 board. These
connectors are stackable and hence any other Arduino-compatible shields can be stacked on it. The kit has options to

operate at either 3.3 V or 5.0 V. Figure 3-1 shows the DVK board and its general description.

Figure 3-1. General Description of DVK Board

Arduino Arduino
Compatible 1/10 Compatible 1/10
Header (J3) Header (J4)

SPI F-RAM
FM25W256 (U1)

CYISFRAMKIT 001

Power LED ‘w-i“;_i’ m@
LED1 R2

( ) LED:TV51 __gpWoo

Power Select
Jumper (J5)

Arduino
Compatible I/O
Header (J1)

Arduino
Compatible 1/0
Header (J2)

I°’C F-RAM
FM24W256 (U2)

Debug Header
7

Debug/Arduino
Compatible ICSP
1/0 Header (J6)

I°C Slave

Address

Selection
(SW1)

Refer to the section A.5 Use of 30-ohm Resistors and No Load to modify the CY15FRAMKIT-001 hardware by mounting

two 30-Q resistors to make it Arduino UNO R2-compatible.

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *A
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3.2 Kit Operation and Configuration Guide

3.2.1 Power Supply Jumper

CY15FRAMKIT-001 can operate at either 3.3 V or 5.0 V, selected through jumper J5, as shown in Figure 3-2. The factory
default jumper setting is 5.0 V (short pins 1 and 2). Arduino UNO R3 boards operate at 5.0 V and use the default setting
of the jumper J5. The CY8CKIT-042 Pioneer Kit operates at either 3.3 V or 5.0 V. The default setting of the Pioneer Kit is
3.3 V. Therefore, depending on the voltage setting on the mother board, set jumper J5 to either 5.0 V (short pins 1 and 2)

or 3.3 V (short pins 2 and 3).

1. Do not power the CY15FRAMKIT-001 board through an external power source. The
board is designed to be powered by the mother board.
2. The CY15FRAMKIT-001 operates from 2.7 V to 5.5 V. Exceeding the maximum voltage
CAUTION .
limit (5.5 V) can damage the board.
3. For proper operation of the board, ensure that jumper J5 is set to match the operating
voltage on the motherboard.

Figure 3-2. Power Select Jumper

CY15FRAMKIT-001

~POWER LED @
M 13 P3

Power Select
Jumper (J5)

3.2.2 F-RAM Devices

256-Kbit I°C
F-RAM (U2)

256-Kbit SPI
F-RAM (U1)

CY15FRAMKIT-001

3.2.3 DIP Switch for I°C F-RAM Device Slave Address Select

The DVK provides a DIP switch option, as shown in Figure 3-4, to configure the different slave address for the 1°C
F-RAM by assigning its individual slave select address pins (A2-A0) either to logic LOW ‘0’ or logic HIGH ‘1’. When the
DIP switch is in the ON position, it keeps the respective slave select address pin to logic HIGH using a 4.7 kQ pull-up
resistor. When the DIP switch is not in the ON position, the respective slave select address pins are kept at logic LOW by

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *A 13
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F-RAM device through an internal weak pull-down resistor. The factory default setting for the DIP switch is not in the ON
position which sets the values for A2, A1, and A0 to logic LOW ‘0.
Figure 3-4. DIP Switch for 12C F-RAM A0, A1, and A2 Configuration

DIP Switch (SW1)

3.2.4 Connectors to CY8CKIT-042/Arduino UNO R3 Board

Figure 3-5 shows the Arduino-compatible connectors to the CY8CKIT-042/Arduino UNO R3 boards: J1, J2, J3, and J4.
You can plug the DVK board into the CY8CKIT-042/Arduino UNO R3 board through these connectors. For schematic

details, refer to the Hardware chapter on page 17.
Figure 3-5. Connectors to CY8CKIT-042/Arduino UNO R3 Board

Arduino Arduino
Compatible 110 Compatible 1/10
Header (J3) Header (J4)

,‘a " _‘
e+ ' .
;';-; Hascl (51 | ®
®e

| ON | |
||. Hm.gs...‘....
123 A

O A0 AL A2

e o
zZ z O Q9 Vv L
8 S 2y00942.2.2

Arduino Arduino
Compatible /O Compatible 1/O
Header (J1) Header (J2)
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3.2.5 Debug Headers

Debug headers are provided for easy access to the SPI and I°C communication pins. As shown in Figure 3-6, jumper J6
follows the in-circuit serial programming (ICSP) header pin layout and provides access to the SPI signals. Jumper J7
provides access to the chip select of the SPI F-RAM device and I°C communication signals.

Figure 3-6. Debug Headers

IRy g
Hm 'H'}
0 <
2 S

Debug
Header (J7)

Debug / Arduino
Compatible ICSP I/O
Header (J6)

3.2.6 Test Points

The DVK board provides Vpp (TP3) and GND (TP1 and TP2) test points as shown in Figure 3-7.
Figure 3-7. Test Points

TP1 TP2

TP3 VDD

GND GND

These test point are only for probing and measurement purposes. Do not power the kit using
CAUTION . :
these test points to avoid any damage to the board.

3.3 CY15FRAMKIT-001 with PSoC 4 Pioneer Kit

The CY15FRAMKIT-001 is plugged into the PSoC 4 Pioneer Kit (CY8CKIT-042) through four connectors: J1, J2, J3, and
J4. The default operating voltage of serial F-RAM kit is 5.0 V. To match this, change the voltage setting on the PSoC 4
pioneer kit to 5.0 V. You can also operate at 3.3 V by selecting the 3.3 V power settings on both PSoC 4 pioneer and

serial F-RAM Kkits.

Note: J2 on the CY15FRAMKIT-001 is a 6-pin, single row jumper. On the PSoC 4 Pioneer kit, J2 is a 9x2 header.
Therefore, J2 of the CY15FRAMKIT-001 plugs into the six pins on the extreme left of the outer row of the J2 header on
the Pioneer board. This can be easily observed because the CY15FRAMKIT-001 can be inserted only in one direction.
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Figure 3-8. CY15FRAMKIT-001 Mounted on PSoC 4 Pioneer Kit

3.4 CY15FRAMKIT-001 with Arduino UNO R3 Kit

The CY15FRAMKIT-001 is plugged into the Arduino UNO R3 Kit through four connectors: J1, J2, J3, and J4. These

connector pins are mapped one to one.
Figure 3-9. CY15FRAMKIT-001 Mounted on Arduino UNO R3 Kit

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *A

16



4. Hardware

g

_; CYPRESS

T PERFORM

iﬂll-“h

4.1 Board Details

The CY15FRAMKIT-001 Serial F-RAM DVK consists of the following blocks as shown in Figure 4-1.
m 256-Kbit SPI F-RAM (U1)
m 256-Kbit I2C F-RAM (U2)
®  Power select jumper (J5)
®  Power LED (LED1)
®  DIP switch for device address selection (SW1)
®  Debug headers for SPI/12C signals (J6, J7)
®  Arduino-compatible connectors (J1, J2, J3, J4)
Figure 4-1. CY15FRAMKIT-001 Serial F-RAM DVK Details

Arduino Arduino
Compatible 1/10 Compatible I/O
Header (J3) Header (J4)

SPI F-RAM
FM25W256 (U1)

I’C F-RAM
FM24W256 (U2)

‘ ’3&% L

1 J7
{ Alsgg ® ® Debug Header
| o Il ce-f’*
e ( | I
e 5
o lisol oo !ﬂ ® Debug / Arduino
!g f3ﬂ=sc»q‘ sr O ® Compatible ICSP
B RES ﬂ N ® o I/O Header (J6)
2o * T T [ ‘ 5 J6 r
CY15FRAMKIT-001 [% 332, [l l¥p2 |
Power LED #POWER LED e T oo || 2
(LED1) fam wx ™O : | I°C Device

Lso}_ﬁ‘,sf __cyVoD ‘ chvlibe Soluct Adde Select Address

L T r Switch (SW1)

Power Select
Jumper (J5)

Arduino Arduino
Compatible 1/0 Compatible 1/0
Header (J1) Header (J2)
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Figure 4-2. CY15FRAMKIT-001 Serial F-RAM DVK Pin Mapping for PSoC 4 Pioneer/Arduino UNO R3 Kit
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4.2 Theory of Operation

This section provides the block-level description of the PSoC 4 Pioneer Kit.

Figure 4-3. Block Diagram

Arduino Compatible Headers (J1-J4)

3.3V and 5V

v

Power Selection Jumper
SPI (J5) 12C

Power LED
(LED1)

3.3V or 5V

v
Y v L |

Debug DIP Switch
Header for (SW1) for
SPIF-RAM e | SPI2C  |le—] PCPRAM g | Device Address
(u1) . (u2) .
signals Selection (AD,
{J6, J7) A1, A2)

The CY15FRAMKIT-001 Serial F-RAM DVK provides 256-Kbit SPI and 256-Kbit I°C F-RAM devices. The DVK is a shield
board, which can be plugged into the PSoC 4 Pioneer Kit or the Arduino UNO R3 Kit.

The CY15FRAMKIT-001 Serial F-RAM DVK has a power LED (LED1) indicating the power-ON condition. The kit can
operate either at 3.3 V or 5V selected through jumper J5. The kit also has the option to change the device address for
the I°C F-RAM. The kit also provides debug headers for SPI / I°C signals.

4.3 Functional Description

4.3.1 SPI F-RAM Device (256-Kbit FM25W256)
The CY15FRAMKIT-001 Serial F-RAM DVK uses Cypress 256-Kbit SPI F-RAM device. The device pins are accessible
for reads and writes through Arduino-compatible headers.
Features
m 256-Kbit ferroelectric random access memory (F-RAM) logically organized as 32K x 8
e High-endurance 100 trillion (10'*) read/writes
e 151-year data retention
e NoDelay™ writes
e Advanced high-reliability ferroelectric process
®  Fast serial peripheral interface (SPI)
e Up to 20 MHz frequency
e Direct hardware replacement for serial flash and EEPROM
e  Supports SPI mode 0 (0,0) and mode 3 (1,1)

B Sophisticated write protection scheme
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e Hardware protection using the Write Protect (WP) pin
e Software protection using Write Disable instruction
e  Software block protection for 1/4, 1/2, or the entire array
B Low power consumption
e 250 PA active current at 1 MHz
e 15 pA (typ) standby current
®  Wide voltage operation: VDD = 2.7 Vto 5.5V
B |ndustrial temperature: —40 °C to +85 °C
®  8-pin small outline integrated circuit (SOIC) package
®  Restriction of hazardous substances (RoHS) compliant
Memory Write

All writes to the SPI F-RAM begin with a WREN (Write Enable) opcode (0x06). The WRITE opcode (0x02) is followed by
a two-byte address containing the 15-bit address (A14-A0) of the first data byte to be written into the memory. The upper
bit of the two-byte address is ignored. The subsequent bytes after the two address bytes are data bytes, which are
written sequentially. Addresses are incremented internally as long as the bus master continues to issue clocks and keeps

CS LOW. If the last address of 7FFFh is reached, the counter will roll over to 0000h. Data is written MSB first. The rising
edge of CS terminates a write operation. SPI F-RAM write operation is shown in the following figure.

Figure 4-4. SPI F-RAM Memory Write

o5\ /[

o1 2 3 4 5 6 7

SCK
Sl \0O 0 0 0 O0/1 11\0

HI-Z

SO
Figure 4-5. SPI F-RAM Memory Write

cs \ /[

5 6 7 0 2 3 4 56 7 12 13 14 15 0 2 3 4 5 86 7
SCK H
Opcode 15-bit Address Data
s Mo 0 0 0 o ofT\o /s el | ool alfeofor)osfoelodosealeder)
HI-Z

SO
Memory Read

After the falling edge of CS, the bus master can issue a READ opcode (0x03). Following the READ command is a two-
byte address containing the 15-bit address (A14-A0) of the first byte of the read operation. The upper bit of the address is
ignored. After the read opcode and two address bytes are issued, the device drives out the read data byte on the next
eight clocks on SO pin. The Sl input is ignored during read data bytes. Subsequent bytes are data bytes, which are read
out sequentially. Addresses are incremented internally as long as the bus master continues to issue clocks and CS is
LOW. If the last address of 7FFFh is reached, the counter will roll over to 0000h. Data is read MSB first. The rising edge

of CS terminates a read operation and tristates the SO pin. SPI F-RAM read operation is shown in the following figure.
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Figure 4-6. SPI F-RAM Memory Read
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Status Register Write
The write status register WRSR command (0x01) allows the SPI bus master to write into the status register of the SPI F-

RAM.
Figure 4-7. SPI F-RAM Status Register Write
cs | [

01 23 45 6 7 01 2 3 4 5 6 7
SCK

Data

Opcode
"l\ooo0oo0 o000 @nna@@a

MSB

HI-Z

SO

Status Register Read

The read status register RDSR command (0x05) allows the bus master to verify the contents of the status register of the
SPI F-RAM. Reading the status register provides information about the current state of the write-protection features.
Following the RDSR opcode, the SPI F-RAM device will return one byte with the contents of the status register.

Figure 4-8. SPI F-RAM Status Register Read

e\
01 2 3 456 7 012 3 45 617
SCK ||
Opcode

st " \o o oo o /T\E/T\(
Lz Data
S0 @@@@@@

MSB

For more details on the F-RAM device, refer to the FM25W256 datasheet
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4.3.2 I°)C F-RAM Device (256-Kbit FM24W256)
The CY15FRAMKIT-001 Serial F-RAM DVK uses the 256-Kbit 1°C F-RAM device. The device is accessible for read and
writes through Arduino-compatible headers.
Features
m  256-Kbit F-RAM is logically organized as 32K x 8
e High-endurance 100 trillion (1014) read/writes
e 151-year data retention
e NoDelay™ writes
e Advanced high-reliability ferroelectric process
®  Fast 2-wire serial interface (I°C)
e Upto 1-MHz frequency
e Direct hardware replacement for serial (1I2C) EEPROM
e  Supports legacy timings for 100 kHz and 400 kHz
B Low power consumption
e 100 pA active current at 100 kHz
e 15 PA (typical) standby current
®  Wide voltage operation: VDD =2.7Vto 5.5V
B |ndustrial temperature: —40 °C to +85 °C
®  8-pin small outline integrated circuit (SOIC) package
B Restriction of hazardous substances (RoHS) compliant
Slave Device Address

The first byte that the FM24W256 expects after a START condition is the slave address. As shown in Figure 4-9, the
slave address contains the device type or slave ID, the device select address bits, and a bit that specifies if the
transaction is a read or a write. Bits 7-4 are the device type (slave ID) and should be set to 1010b for the FM24W256.
These bits allow other function types to reside on the I°C bus within an identical address range. Bits 3-1 are the device
select address bits. They must match the corresponding value on the external address pins to select the device. Up to
eight FM24W256 devices can reside on the same 1°C bus by assigning a different address to each. Bit 0 is the read/write

bit (R/W). R/W = ‘1’ indicates a read operation and R/W = ‘0’ indicates a write operation.

Figure 4-9. I°C F-RAM Slave Device Address Register

MSB LSB

1 10| 1|0 | A2|A1] A0 |RW

\__ saven—/\_Device Select

Memory Write

All writes begin with a slave address, then a memory address. The bus master indicates a write operation by setting the

LSB of the slave address (R/W bit) to a '0'. After addressing, the bus master sends each byte of data to the memory and
the memory generates an acknowledge condition. Any number of sequential bytes may be written. If the end of the
address range is reached internally, the address counter will wrap from 7FFFh to 0000h.
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Single-Byte Write:
Figure 4-10. I°C F-RAM Single Byte Memory Write
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Multi-Byte Write:

Figure 4-11. I°C F-RAM Multisystem Memory Write

~ Start

\ Stop
By Master ) Address & Data
! } } ] '
[T T T I I T FT T 1T T [T T T I T
S Slave Address 0 A Address MSB A Address LSB A Data Byte A Data Byte AP
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By F-RAM 4 4 4 4

Acknowledge

Memory Read

There are two basic types of read operations: current address read and selective (random) address read. In a current
address read, the FM24W256 uses the internal address latch to supply the address. In a selective read, the user
performs a procedure to set the address to a specific value.

Current Address and Sequential Read

The FM24W256 uses an internal latch to supply the address for a read operation. A current address read uses the
existing value in the address latch as a starting place for the read operation. The system reads from the address
immediately following that of the last operation.

To perform a current address read, the bus master supplies a slave address with the LSB set to a '1". This indicates that
a read operation is requested. After receiving the complete slave address, the FM24W256 will begin shifting out data
from the current address on the next clock. The current address is the value held in the internal address latch.

Beginning with the current address, the bus master can read any number of bytes. Thus, a sequential read is simply a
current address read with multiple byte transfers. After each byte the internal address counter will be incremented.

Figure 4-12. I°C F-RAM Single Byte Current Address Read

M No
By Master ) Start Address Acknorledge
' i||\'H| T T T T ' o
S Slave Address 1| A Data Byte 1P
\ [ L [ 1 | | [ |
By F-RAM Acknowledge Data
Figure 4-13. I°C F-RAM Multisystem Sequential Read
. No
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Selective (Random) Read

A simple technique allows a user to select a random address location as the starting point for a read operation. This

involves using the first three bytes of a write operation to set the internal address followed by subsequent read
operations.

To perform a selective read, the bus master sends out the slave address with the LSB (R/W) set to 0. This specifies a
write operation. According to the write protocol, the bus master then sends the address bytes that are loaded into the
internal address latch. After the FM24W256 acknowledges the address, the bus master issues a START condition. This

simultaneously aborts the write operation and allows the read command to be issued with the slave address LSB set to a
'1'. The operation is now a current address read.

Figure 4-14. F-RAM I°C Selective (Random) Read

", Start
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By Master l Address ) Start Address Acknowledge
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Cypress provides four example projects with the CY15FRAMKIT-001 Serial F-RAM DVK package. These example
projects help you to understand the serial F-RAM interface with a microcontroller. The example projects are based on
PSoC 4 Pioneer Kit and Arduino UNO R3 Kit.

Download the example projects from www.cypress.com/go/CY15FRAMKIT-001. The installer will place the example
projects under <Install Directory>\CY15FRAMKIT-001 Serial F-RAM Kit\1l.0\Firmware\ folder

The following example projects are PSoC 4-based and need the PSoC Creator software and the PSoC 4 Pioneer Kit.
B  PSoC4_FRAM_SPI

®m  PSoC4_FRAM_I2C
The following example projects are Arduino-based and need Arduino IDE and Arduino UNO R3 Kit.
B Arduino_FRAM_SPI
B Arduino_FRAM_I2C

5.1 Programming PSoC 4 Pioneer Kit

Follow these steps to program the PSoC 4 example projects (PSoC4_FRAM_SPI project is shown here):

1. Launch PSoC Creator from Start > All Programs > Cypress > PSoC Creator 3.1 > PSoC Creator 3.1. If
PSoC Creator is not installed, download from www.cypress.com/psoccreator.

2. On the Start Page, under Examples and Kits section, choose Kits > CY15FRAMKIT-001. A list of example
projects appears, as shown in Figure 5-1. Click on the desired example project.
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Figure 5-1. Opening Example Project from PSoC Creator
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3. Select the folder where you want to save the project and click OK.
4. Build the code example by clicking Build > Build <Project name> to generate the hex file.
Figure 5-2. Build Project from PSoC Creator
File Edit View Proj Build | _Debug  Togle  Window  Helog
Ed 13 j—j E & @S ||ﬂ| Build PSoC4_FRAM_SPI  Shift+Fé  |Deblig
P @ ‘g’ a T STEan PO PR _SPT
Workspace Explorer (1 project) | | Clean and Build PSoC4_FRAM_SPI | Start Page
& g =) 1
a J i 2
9 Vorkspace PSoC4 FRAM S| g il File Ctrl+F6 -
P2 Project 'PSoC4_FRAM
i-[E] TopDesign.cysch ‘3 Generate Application 4
5
>:P P5oC4_FRAM_SPley) =] Generate Project Datasheet ‘
FHZ) Header Files — -
B+ Source Files 5 -
H . b=l La’
i ielc] Imaine g 5
H ai}
EH) Generated_Source =4 10
EHED PSoC4 -
&3 BLUE_LED g 1
= e @
5. Select the operating voltage. CY15FRAMKIT-001 can operate at either 3.3 V or 5.0 V, selected through jumper

J5. The factory default jumper setting is 5.0 V (short pins 1 and 2). Arduino UNO R3 boards operate at 5.0 V
and use the default setting of the jumper J5. The CY8CKIT-042 Pioneer Kit operates at either 3.3 V or 5.0 V.
The default setting of the Pioneer Kit is 3.3 V. Therefore, depending on the voltage setting on the mother board,
set jumper J5 to either 5.0 V (short pins 1 and 2) or 3.3 V (short pins 2 and 3). To program PSoC 4, connect the
Pioneer board to a PC using the USB cable connected to USB Mini-B connector J10 as shown in Figure 5-3.
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Figure 5-3. Connect PSoC 4 Pioneer Kit to PC through USB

6. Click Debug > Program in PSoC Creator.

Figure 5-4. Program Device from PSoC Creator
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H . Descr
EJ Header Files Mew Breakpoint This
EHCD Source Files 2 B FrrlL S The
Q) ne - e o
B+ Generated_Source -d e inel
EHED PSoC4

3l

7. If the device is not yet acquired, PSoC Creator will open the programming window. Select KitProg and click the
Port Acquire button.

EHC) BLUE_LED L

Figure 5-5. Acquire Device from PSoC Creator

Select Debug Target M

% KitProg/1222172E03242400 KitProg/1222172E03242400
POWER =3
VOLTAGE_ADC = 3316
FREQUENCY = 2000000
PROTOCOL = SWD

KitProg version Expecting 2.00, but

found 1.03
Show all targets v] [ Port Setting "

8. After the device is acquired, it is shown in a tree structure below the KitProg. Now, click the Connect button.
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Figure 5-6. Connect Device from PSoC Creator
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Click OK to exit the window and start programming.

Figure 5-7. Program Device from PSoC Creator
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Disconnect

5.2 UART Setup

d D

This section describes the UART interface setup to display the PSoC 4 example project output on the PC either using
HyperTerminal or PUTTY as an alternative to HyperTerminal for the serial COM connection.

The PSoC 5LP device on PSoC 4 Pioneer Kit can be configured as USB to UART Bridge as shown in Figure 5-8. Both
the PSoC 4 example projects include UART communication to transmit the result to PC via USB port. For more details on
the hardware setup and the architecture, refer to the PSoC 4 Pioneer Kit web page: http://www.cypress.com/?rid=77780.
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Figure 5-8. Block Diagram of UART Connection between PSoC 4 and PSoC 5LP

B9 JB_10 POl OS]
P12[6] P12[7] UART RX UART TX
UART RX UART TX
USB D+ P15[6]
. PSoC 5LP PSoC 4
Mini B =5 pism" O°C O SoC

Connect the RX port of the PSoC 4, accessible through J4_1 (SI) on the CY15FRAMKIT-001 kit to J8 10
(TX). Similarly connect the TX port of PSoC 4, accessible through J4 2 (SO) on the CY15FRAMKIT-001 kit

to J8_9 as shown in Figure 5-9.
Figure 5-9. UART Connection on PSoC 4 Pioneer Kit

Connect USB Mini-B to J10. The kit enumerates as a KitProg USB-UART and is available under the Device Manager >
Ports (COM & LPT). A communication port is assigned to the KitProg USB-UART.
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Figure 5-10. KitProg USB-UART in Device Manager
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Example Projects

The following sections demonstrate the procedure to setup the serial connection using HyperTerminal or PuTTY on PC
to communicate with the PSoC 4 Pioneer Kit.

5.2.1 HyperTerminal Setup

Open HyperTerminal and select File > New Connection and enter a “Name” for the new connection; click OK.

Figure 5-11. Open New Connection

B " New Connection - HyperTerminal

File Edit View Call Transfer Help

& &5 D5

r y
Connection Description M

| o
| | FRAM_SPI_Example_HyperTeminal

New Connection

Enter a name and choose an icon for the connection

leon

Disconnected Auto detect  Auto detect SCROLL | CAPS
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A new window opens where the communication port can be selected.

Select the appropriate communication port “COMX” (or the specific communication port that is assigned to
KitProg USB-UART) in Connect using and click OK to go to the next setting for HyperTerminal.

This code example uses COM5. Verify the COM setting for your setup and select the appropriate COMX.

W

1.

Figure 5-12. Select Communication Port
T [ |

Connect To

FRAM_SPI_HyperTeminal

-

Enter details for the phone number that you want to dial:

United States (1)

Country/reqion:
Area code: 9

Phone number:

Connect using: [COME > v

[ ok || cancsl |

The COMX Properties window opens with the Port Settings tab. Click Restore Defaults and then configure
'Bits per second'’, 'Data bits', 'Parity’, 'Stop bits', and 'Flow control' as shown in Figure 5-13 and click OK. If you

2.
change the PSoC 4 UART port setting in the example project, make sure the same setting is applied on
HyperTerminal. Click OK to start the communication.
Figure 5-13. Configure Communication Port
— 3 5

COMS Properties

Port Settings
z)

Bits per second: [BBDD

Data bits: [8

Parity: [None

Stop bits: ['I

Flow cantrol: [None

Restore Defaults

=

OK

HyperTerminal window opens to display the PSoC 4 example projects output.

3.
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Figure 5-14. Configure Communication Port

B " FRAM_SPI_Example_HyperTerminal - HyperTerminal o .. - =1L=

File Edit View Call Transfer Help
0= B DB

CY15FRAMKIT-081 Kit - PSoC4 SPI F-RAM Example Project
SPI F-RAM Initialized

Data written to the address 0x2000 = OxA5
Data read from the address 0x2000 = BxAS

Data written to the address 0x3456 =

=01 002 0:03 0x04 =05 =06 007 0x08 =09 0xB6A @
=0B 0:0C 0::0D 0%6E 0Ox0F 0x10

Data read from the address Bx3456 =

=01 002 003 0x04 =05 0x06 0207 0x08 =09 0x0A 0
=0B 0x0C 0x0D 0x6E Ax0BF =10

Status Register Data Write = BOxB8
Status Register Data Read = 0x08

Status Register Data Write = 0x00
PSoC4 SPI F-RAM Example Project - PASS

Connected 0:00:30 Auto detect 9600 8-N-1

5.2.2 PuTTY Setup

PuUTTY is a free SSH and telnet client for Windows. You can download PuTTY from www.putty.org/.
1. Double-click the putty icon and select Serial under Connection.

Figure 5-15. Open New Connection

»
ﬁ PuTTY Configuration &J

Category:

=R Sgssion Basic options for your PUTTY session

i Specify the destination you want to connect to
[=)- Temminal .
.. Keyboard Host Name (or IP address) Port
- Eell 2
- Features Connection type:
= Window ()Raw () Telnet () Rlogin @ SSH  (7) Serial
- Appearance
- Behaviour
- Translation
- Selection

- Colours "
Default Settings
=) Connection Lond

... Data

- Prosey

- Rlogin

@ Closs window on exit:

() Mways () Never @ Only on clean exit

Load, save or delete a stored session
Saved Sessions

About [ Open ] [ Cancel ]

2. A new window opens where the communication port can be selected. Enter the COMX in Serial line to
connect to. This code example uses COM5. Verify the COM setting for your setup and select the appropriate
COMX.
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Select Speed (baud), Data bits, Stop bits, Parity, and Flow control under Configure the serial line. Click

Session and select Serial under Connection type.

Figure 5-16. Select and Configure Communication Port

ﬁ PUTTY Configuration ﬂw

Category:

[=1- Session

. Logging
L—__| Teminal
- Keyboard
- Bell
- Features
- Window
- Appearance
- Behaviour
- Translation
- Selection
- Colours
- Connection
- Data
- Prowgy
- Telnet
- Rlogin
- 55H
B Serial

About

Cptions controling local seral lines
Select a seral line
Serial line to connect to COM5

Configure the serial line

Speed (baud) 9600
Data bits 8
Stop bits 1

=

[ Open J ’ Cancel ] W

Select the Session under Category and set the Communication type: to Serial. Click Open.

Figure 5-17. Select Communication Type in PuTTY

ﬁ PuTTY Cenfiguraticn

-- [t

[=- Terminal

- Keyboard
- Bell

- Features
= Window

- Appearance
- Behaviour
- Tranglation
- Selection
- Colours
=+ Connection
.. Data
.- Prosy
- Telnet
- Rlogin
(- S5H
- Serial

Basic options for your PuTTY session

Specify the destination you want to connect to

Serial line Speed
COM5 5600
Connection type:

() Raw () Telnet () Rlogin ©) SSH @) Serial

Load, save or delete a stored session
Saved Sessions

Default Settings Load

Save

Close window on exit:
) Mways () Mever (@ Only on clean exit

[ Cpen J [ Cancel

Example Projects

4. The COM terminal software displays the data from PSoC 4. For example, the initial screen of the SPI example

project is shown in Figure 5-18.
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Figure 5-18. Data Displayed on PuTTY

22 COMS - PuTTY [E=EER ™)

5.3 Project: PSoC 4 F-RAM SPI

5.3.1 Project Description

This example project runs on the CY8CKIT-042 PSoC 4 Pioneer Kit and provides the SPI F-RAM component and APIs to
write and read F-RAM memory/status register. The example project will write to F-RAM, read from F-RAM, and indicate
PASS by illuminating the RGB LED (D9) on PSoC 4 in blue. The output is also displayed on HyperTerminal through
UART.

5.3.2 Hardware Connections

Refer to section 5.2 for UART setup. Apart from this, all other connections are hardwired on the board. Open
PSoC4_FRAM_SPIl.cydwr in the Workspace Explorer and select the suitable pin.

Table 5-1. PSoC 4 F-RAM SPI I/O Pin Assignment

F-RAM 1/0 PSoC 4 Pin
Cs# P3 4
Sl P3 0
o) P3 1
SCK PO_6
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Figure 5-19. PSoC 4 F-RAM SPI Example Project Pin Configuration

Example Projects

PSoC4_FRAM_SPLcydwr | vdbx
=
§ Alias Name / Port Pin Lock
& - _—
- S PO[4] SCB1:I2C:SCL, SCB1:SPI:MOSI W
¥ 5 =2 \UART: =X\ | 5CB1:UART:RX | 28 M
______ \EBRT: v | B0IS] SCBLSIZCISDA, SCB:SPI:MISO = -
BLUE_LED | 20[3] v |27 v
cs P3[4] SCB1:SPI:SS1, TCPWM2:P v |18 -
SCK PO[€] SCB1:SPI:SCLK, EXTCLK v | 30 b8
P3[0] SCB1:12C:SCL, SCB1:SPI:MOST
SE TCPWMO:P, SCB1:UZRT:RX B a4
P3[1] SCB1:I2C:SDA, SCB1:SPI:MISO
TCPWMO:N, SCB1:UART:TX

Pol4]

CY8C4245AXI-483

g
ol
S
3
2
7
2
®

4b

5.3.3 Firmware Flow

Following steps provide the example project firmware flow.

a.

=

~ o o o

S

Initialize the F-RAM SPI and USB-UART block.

Wait for “Enter” key from the display (HyperTerminal / PuTTY)

Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address.

Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte.
Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address.

Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte variable.
Write 16 bytes of data from data_bytes array (1, 2, 3, ...,16) to EXAMPLE_ADDR_2 (0x3456) address.

Read 16 bytes of data from EXAMPLE_ADDR_2 (0x3456) address through the read function.
Write EXAMPLE_STS_REG_VALUE (0x08) to the status register.

Read the status register and store in the 'statug_reg' variable.

Compare the read data with the written data. If successful, glow the blue LED.

Clear the status register.

5.3.4 Verify Output

The data output is shown in Figure 5-20 and Figure 5-22.
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Figure 5-20. PSoC 4 F-RAM SPI Example Project Output - Waiting for Enter Key pressed by the User

&P COMS - PuTTY a & ]

Figure 5-21. PSoC 4 F-RAM SPI Example Project Output Data

-
£ COMS - PuTTY &

5.3.5 Modifying the Project
Open file main.c in the project under Source Files and change the address and data byte values by setting the variables

EXAMPLE_ADDR_1, EXAMPLE_ADDR_2and EXAMPLE_DATA_BYTE shown in Figure 5-22. For example change:
0x2000 to 0x1200, 0x3456 to 0x1600, Oxa5 to Ox5a.
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Figure 5-22. Snapshot of main.c Source File

22¢ #include <device.h>»

23} #include <stdio.h>

24! #include "FRAM SPI.h"

25

26 // Size of data buffer

27 #define BUFFER_SIZE (léu)

28

22! #define STRING SIZE (50u)

31i // Emample F-RAM Address

32 #define EXAMPLE ADDR 1 (0x2000)
4 4 Example F-R&M Rddress

35 #define EXRMPLE_RDDR_2 (0x3456)
a
7 '/ Example F-RAM Data
2! #define EXAMPLE DATZ EYTE (Oxas)

Example Projects

Also the user can change the burst write data shown in Figure 5-23. For example, change i+1 to i+3 at line 83 will
initialize the input data from 0x03 — 0x13.

Figure 5-23. Snapshot of main.c source file for initializing input data buffer

e |
=R

/4 Initialization of variables
for(i = 0; 1 < BUFFER SIZE; 1++)
{
fram rd datali]l = 0;
data bytes[i] = i+l;

ST S

Figure 5-24. Modified SPI F-RAM Project Output

&P COMS - PuTTY
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Build the project with the above changes and program the Pioneer kit. The output will show the data 0x5a written to
address 0x1200 and data 0x03 — 0x13 written from address 0x1600 as shown in Figure 5-24. APIs provided in the next
section can be used to build different applications.
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5.3.6 APIs

5.3.6.1 void FRAM_SPI_Init(void)

Description: Initializes the SPI block.
Parameters: None
Return Value: None
Side Effects: None

5.3.6.2 uint8 FRAM_SPI_Write(uint32 addr, uint8 data_write)

Description: Write a single byte of data to F-RAM.
Parameters: uint32 addr: 32 bit F-RAM address for write.
uint8 data_write: data byte to be written.
Return Value: uint8: 0 - Communication Error
1 — Success
Side Effects: None

5.3.6.3 uint8 FRAM_SPI_Read(uint32 addr, uint8 *data_read)

Description: Read a byte of data from F-RAM.
Parameters: uint32 addr : 32 bit F-RAM address for read
uint8 *data_read. : 8 bit pointer variable to hold data
Return Value: uint8: 0 — Communication Error
1 — Success

Side Effects: None

Example Projects

5.3.6.4 uint8 FRAM_SPI_BurstWrite(uint32  addr, uint8  *data_write_ptr,  uint32

total_data_count)

Description: Write total_data_count number of data into F-RAM.
Parameters: uint32 addr: 32 bit F-RAM address for write.
uint8 *data_write_ptr: Pointer to an array of data bytes to be written.
uint32 total_data_count: Number of data bytes to be written.
Return Value: uint8: 0 — Communication Error
1 — Success
Side Effects: None

5.3.6.5 uint8 = FRAM_SPI| BurstRead(uint32  addr, uint8  *data_read_ptr, uint32

total_data_count)

Description: Read total_data_count number of data from F-RAM.
Parameters: uint32 addr : 32 bit F-RAM address for read.
uint8 *data_read_ptr: Pointer to an array for storing data bytes.
uint32 total_data_count: Number of data bytes to be read.

Return Value: uint8: 0 — Communication Error
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1 — Success
Side Effects: None

uint8 FRAM_SPI_ Status_Reg_ Write (uint8 data_byte)

Description: F-RAM Status Register Write
Parameters: uint8 data_byte -> 1 byte status register data to be written
Return Value: uint8: 0 — Communication Error
1 — Success
Side Effects: None

uint8 FRAM_SPI_ Status_Reg_Read (uint8 * status)

Description: F-RAM Status Register Read
Parameters: uint8 * status : pointer to hold status register value
Return Value: uint8: 0 — Communication Error
1 — Success
Side Effects: None

5.4 Project: PSoC 4 F-RAM I°C

5.4.1 Project Description

Example Projects

This example project runs on the CY8CKIT-042 PSoC 4 Pioneer Kit and provides the I°C F-RAM component and APIs to
write and read F-RAM memory. The example project will write to F-RAM, read from F-RAM, and indicate PASS by
illuminating the RGB LED (D9) on PSoC 4 in blue. The output is also displayed on HyperTerminal through UART.

5.4.2 Hardware Connections

Refer to section 5.2 for UART setup. Apart from this, all other connections are hardwired on the board. Open
PSoC4_FRAM_I2C.cydwr in the Workspace Explorer and select the suitable pin.
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Table 5-2. PSoC 4 F-RAM I°C I/O Pin Assignment

F-RAM 1/O PSoC 4 Pin
SDA P4 1
scCL P4 0
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Figure 5-25. PSoC 4 F-RAM 1’Cc Example Project Pin Configuration

PSoC4_FRAM_T2C.cydwr ~ 41

Alias Name Port Pin L

D4[0] SCBO:12€:5CL, SCBO:SPI:MOST

D4[1] SCBO:12C:SDA, SCBO:SPI:MISO

BO[4] SCBL:12€:SCL, SCB1:SPI:MOST
SUART:RK

e, P0[5] SCB1:12G:SDA, SGB1:SPL:MISO

A A

AEIEI R

E &5 f&&& g g EBLUE_LED paral

cYacapasAxi-4sy  MEETE
44.TQFP e

4 Pins | \\ Analog | () Clodks . # Interrupts | % System | [£] Directives | (5] Flash Security

5.4.3 Firmware Flow

Following steps provide the example project firmware flow.

a.

o

o o

Init the F-RAM I°C and USB-UART blocks.

Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address.

Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte variable.

Write 16 bytes of data from data_bytes array (1, 2, 3, ...,16) to EXAMPLE_ADDR_2 (0x3456) address.
Read 15 bytes of data from EXAMPLE_ADDR_2 (0x3456) address through the random read function.
Read the sixteenth byte through the current read function.

Compare the read data with the written data and illuminate the blue LED if read is PASS.

5.4.4 Verify Output

The RGB LED illuminates in blue if the read passes. If read fails, the RGB LED will not glow. The data output is shown in
Figure 5-26 and Figure 5-27.

Figure 5-26. PSoC 4 F-RAM 1’c Example Project Output - Waiting for Enter Key pressed by the User

',g-"t:zm PuTTY | ——
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Figure 5-27. PSoC 4 F-RAM 1’c Example Project Output Data

P COMS - PuTTY

[E=REE

5.4.5 Modifying the Project

Open main.c in the project under Source Files and change the values of EXAMPLE_ADDR_1, EXAMPLE_ADDR_2and
EXAMPLE_DATA_BYTE shown in Figure 5-28. For example change 0x2000 to 0x1200, 0x3456 to 0x1600, Oxa5 to

Ox5a

Figure 5-28. Snapshot of main.c source file

PSoC4_FRAM_I2C.cydwr ./ main.c

e <device.h>
e <stdio.h>
e "FRAM T2C.h"

of data buffer
BUFFER_SIZE

B L S U

o

of
STRING SIZE

string al

(16

______ or Uakl output

u)

(50u)

F-RAaM

{/ Example Lddress
$define EXAMPLE ADDR 1

F-RAM

oo ks L B

// Example hddress
#define EXBMPLE RDDR 2

-

// Example F-RBM

#define EXAMPLE DATA BYTE

W L) L0 L G0 L G Lo B B RS B RS ORI BF ORI BRI B
o m ]

(0x2000)

(0x3456)

(Oxab)

Also the user can change the burst write data shown in Figure 5-29. For example, change i+1 to i+3 at line 80 will
initialize the input data from 0x03-0x13.

Figure 5-29. Snapshot of main.c source file for initializing input data buffer

81 fram rd data[i]

7 y Initialize wvariables
78 for(i = 0; i < BUFFER SIZE; i++)
A=) i
BO data bytes[i] = i+1;
= 0;
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With these changes, build the project and program the kit. Output will show the data 0x5a written to address 0x1200 and
data 0x03 — 0x13 written from address 0x1600 as shown in Figure 5-30. APIs provided in the next section can be used
to build different applications.

Figure 5-30. Modified I°C F-RAM Project Output

"B COMS - PuTTY ESARCE ™"k

5.4.6 APIs

The following APIs are defined for the PSoC 4 F-RAM I°C. These APIs are the same for Arduino as well.
5.4.6.1 void FRAM_I2C_Init(void)

Description: Initializes the 12C block.
Parameters: None
Return Value: None
Side Effects: None

5.4.6.2 uint32 FRAM_I2C_Write (uint8 slave_id, uint32 addr, uint8 *data_write_ptr, uint32
total_data_count)

Description: Write total_data_count number of data into F-RAM specified by slave_id.
Parameters: uint8 : 7 bit Slave ID

uint32 addr: 32 bit F-RAM address for write.

uint8 *data_write_ptr: Pointer to an array of data bytes to be written.

uint32 total_data_count: Number of data bytes to be written.

Return Value: For PSoC 4,
uint32 : Error Status
FRAM_I2C_MSTR_NO_ERROR -- (0x00u)
FRAM_[2C_MSTR_ERR_ARB_LOST -- (0x01u)
FRAM_[2C_MSTR_ERR_LB_NAK  -- (0x02u)
FRAM_[2C_MSTR_NOT_READY -- (0x04u)
FRAM_[2C_MSTR_BUS BUSY -- (0x08u)

FRAM_I2C_MSTR_ERR_ABORT_START  -- (0x10u)
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FRAM_[2C_MSTR_ERR_BUS_ERR -- (0x100u)
FRAM_[2C_MSTR_ERR -- (OXFFu)
For Arduino UNO,
uint32 : Error Status
Success -- (Ox00u)
Data too long to fit in transmit buffer -- (Ox01u)

Received NACK on transmit of address  -- (0x02u)

Received NACK on transmit of data -- (Ox03u)
Other error -- (0x04u)
Side Effects: None

uint32 FRAM_I2C _Current_Read (uint8 slave id, uint8 *data read ptr, uint32
total_data_count)

Description: Read total_data_count number of data from the current address of the F-RAM
specified by slave_id.

Parameters: uint8 : 7 bit Slave 1D
uint8 *data_read_ptr: Pointer to an array for storing data bytes.
uint32 total_data_count: Number of data bytes to be read.

Return Value: For PSoC 4

uint32 : Error Status

FRAM_I2C_MSTR_NO_ERROR -- (0x00U)
FRAM_I2C_MSTR_ERR_ARB_LOST -- (0x01u)
FRAM_I2C_MSTR_ERR_LB_NAK  -- (0x02u)
FRAM_I2C_MSTR_NOT_READY - (0x04u)
FRAM_I2C_MSTR_BUS_BUSY -- (0x08u)
FRAM_I2C_MSTR_ERR_ABORT_START  -- (0x10u)
FRAM_I2C_MSTR_ERR_BUS_ERR -- (0x100u)
FRAM_I2C_MSTR_ERR - (OXFFu)

For Arduino UNO, returns the number of bytes read

Side Effects: None

uint32 FRAM_ 12C_Random_Read (uint8 slave_id, uint32 addr, uint8 *data_read_ptr,
uint32 total_data_count)

Description: Read total_data_count number of data from F-RAM specified by slave_id.
Parameters: uint8 : 7 bit Slave 1D

uint32 addr: 32 bit F-RAM address for read.

uint8 *data_read_ptr: Pointer to an array for storing data bytes.

uint32 total_data_count: Number of data bytes to be read.
Return Value: For PSoC 4

uint32 : Error Status

FRAM_[2C_MSTR_NO_ERROR -- (0x00u)
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FRAM_I2C_MSTR_ERR_ARB_LOST -- (0x01u)

FRAM_I2C_MSTR_ERR_LB_NAK  -- (0x02u)
FRAM_I2C_MSTR_NOT_READY - (0x04u)
FRAM_I2C_MSTR_BUS_BUSY - (0x08u)
FRAM_I2C_MSTR_ERR_ABORT_START  -- (0x10u)
FRAM_I2C_MSTR_ERR_BUS_ERR -- (0x100u)
FRAM_I2C_MSTR_ERR - (OXFFu)

For Arduino UNO, returns the number of bytes read
Side Effects: None

5.5 Programming Arduino UNO Kit

Follow these steps to program the Arduino example projects (Arduino_FRAM_SPI project is shown here):

1. Install Arduino IDE. You can download Arduino IDE software from the Arduino webpage:
http://arduino.cc/en/Main/Software.

2. Open the “Arduino_FRAM_SPI“ project folder and double-click the FRAM_SPI_Example.ino file.
Figure 5-31. Arduino Project File Open

* Mame Type

|l | €9 FRAM_SPI Example Arduino file
| CYSPIFRAM H File
.| CYSPIFRAM CPP File

3. Compile the code example by clicking Sketch > Verify / Compile. At the end of successful compiling, the IDE
displays the status “Done compiling.” and generates a binary sketch.

Figure 5-32. Compile the Arduino Project
FRAM_SPT_Example | Arduino 1.0.6 o =[]
File Edit Tools Help

Verify / Compile Ctrl+R

FRAM_ Show Sketch Folder Ctrl+K

i Import Library... 2

Add File... B Semiconductor Technology Pwt
SPI F-FiM Example Project.

-~

This file iz free software; you can rediscribure it and/or
it under the terms of either the GNU General Public Licens

LI T, BT ORI
* s o s ow

4. To program the Arduino UNO kit, connect the PC to the Arduino board via USB port using an Arduino UNO
compatible USB cable as shown in Figure 5-33. Because Arduino UNO kits operate at 5V, ensure that the
power select jumper (J5) on the CY15FRAMKIT-001 is placed between pin 1 and pin 2 for 5 V operations.
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Figure 5-33. CY15FRAMKIT-001 mounted on Arduino UNO R3 Kit
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5. Load the binary sketch file by clicking the Upload button.
Figure 5-34. Program the Arduino UNO R3 Kit

FRAM_SPI_Example | Arduino 1.0.6
File Edit Sketch Tools Help

Upload

FRAM_SPI_Example

= Rascyl s (e X»)

resttjove (O

)] i o
-
ogo .o g

[E=% EoR ==

Fi

e B R P

5.6 Project: Arduino F-RAM SPI

5.6.1 Project Description

Copyright (c) 2014 by Cypress Semiconductor Technology Pwt)
SPI F-FAM Example Project.

*
*
*
* This file iz free software; you can redistribute it and/or
*
*
*

mihldahad hir the Fres Saftmmare Famdatdom

»

ﬂ

it under the terms of either the GMT General Public Licens
or the GNU Lesser General Public License wersion 2.1, both

Example Projects

This example project runs on the Arduino UNO board and provides SPI APIs to write and read F-RAM memory/status
register. The example project will write to F-RAM, read from F-RAM, and display the results in serial output window.

5.6.2 Hardware Connections

No additional hardware connection is required for this project because all connections are hardwired on the board. The

Arduino SPI library uses the following pins by default.

Table 5-3. Arduino F-RAM SPI I/0 Pin Assignment

F-RAM I/O Arduino Pin
CS# D10
Sl D11
SO D12
SCK D13
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5.6.3 Firmware Flow

Following steps provide the example project firmware flow.
a. Initialize the F-RAM SPI.

b. Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address. Display the written data on serial
output.

Read a byte from address EXAMPLE_ADDInitialize the F-RAM SPI.

. Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address. Display the written data on serial
output.

e. Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte variable. Display the read
data on serial output.

2 o

f. Compare the written and read data and display the result (PASS/FAIL) on serial output.
g. Write 16 bytes of data from data_bytes array (1, 2, 3, ...,16) to EXAMPLE_ADDR_2 (0x3456) address.
h. Read 16 bytes of data from EXAMPLE_ADDR_2 (0x3456) address through the read function.

Compare the written and read data and display the result (PASS/FAIL) on serial output.
j-  Write EXAMPLE_STS_REG_VALUE (0x08) to the status register.

k. Read the status register and store in the 'statug_reg' variable.

I.  Compare the written and read data and display the result (PASS/FAIL) on serial output.

m. Clear the status register.

5.6.4 Verify Output
Open Tools >Serial Port and select the appropriate COM port for communication as shown in Figure 5-35.
Figure 5-35. Serial Port in Arduino IDE
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Open Tools > Serial Monitor to view the serial output as shown in Figure 5-36 and Figure 5-37.

Figure 5-36. Serial Monitor in Arduino IDE
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Figure 5-37. Serial Monitor Output for SPI F-RAM Project

Example Projects

1. Write Data A5
2. Read Data A5
Write-Read : PASS

1 2 3
4., Read Data Rrray
1 2 3
Write-Read : PASS
5. Status Register
&. Status Register

5.6.5 APIs

F-BEEM 5PI Exemple Project Start

3. Write Data Array

4 5 [ 7 g ] s B c D E
4 5 [ 7 g 9 L B c D E
Write &
Read &

Status Begister Write-Read : PRASS
F-REM SPI Example Project End

5.6.5.1 void FRAM_SPI_lInit()

Description:
Parameters:
Return Value:

Side Effects:

Initializes the SPI library
None
None

None

5.6.5.2 void FRAM_SPI_Write(uint32 addr, uint8 data_write)

5.6.5.3

5.6.5.4

Description:

Parameters:

Return Value:
Side Effects:

Write a single byte of data to F-RAM.
uint32 addr: 32 bit F-RAM address for write.
uint8 data_write: data byte to be written.
None

None

uint8 FRAM_SPI_Read(uint32 addr)

Description:
Parameters:
Return Value:
Side Effects:

void FRAM_SPI_BurstWrite(uint32 addr, uint8 *data_write_ptr,

Read a byte of data from F-RAM.
uint32 addr : 32 bit F-RAM address for read.
uint8 : data read

None

total_data_count)

Description:

Parameters:

Return Value:

Side Effects:

Write total_data_count number of data into F-RAM.

uint32 addr: 32 bit F-RAM address for write.

uint8 *data_write_ptr: Pointer to an array of data bytes to be written.
uint32 total_data_count: Number of data bytes to be written.

None

None
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5.6.5.5 void FRAM_SPI BurstRead(uint32 addr, uint8
total_data_count)
Description: Read total_data_count number of data from F-RAM.
Parameters: uint32 addr : 32 bit F-RAM address for read.

Example Projects

*data_read_ptr,

uint8 *data_read_ptr: Pointer to an array for storing data bytes.

uint32 total_data_count: Number of data bytes to be read.

Return Value: None
Side Effects: None

5.6.5.6 void FRAM_SPI_ Status_Reg_Write (uint8 data_byte)

Description: F-RAM Status Register Write

Parameters: uint8 data_byte -> 1 byte Status register data to be written
Return Value: None

Side Effects: None

5.6.5.7 uint8 FRAM_SPI_ Status_Reg_ Read (void)

Description: F-RAM Status Register Read
Parameters: None

Return Value: uint8: 1 byte status register data
Side Effects: None

5.7 Project: Arduino F-RAM I°C

5.7.1 Project Description

uint32

This example project runs on Arduino UNO board and provides I°C APIs to write and read from F-RAM memory. The
example project will write to F-RAM, read from F-RAM, and display the results in serial output window.

5.7.2 Hardware Connections

No additional hardware connection is required for this project because all connections are hardwired on the board. The

Arduino WIRE library (I2C) uses the following pins by default.

Table 5-4. Arduino F-RAM I°C I/O Pin Assignment

F-RAM I/O Arduino Pin
SDA A4
SCL A5

5.7.3 Firmware Flow

Following steps provide the example project firmware flow.

a. Initialize F-RAM I°C and provide startup delay.

b. Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address.
c. Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte variable. Display the

read data on serial output.

d. Compare the written and read data and display the result (PASS/FAIL) on serial output.
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5.7.4 Verify Output

Open Tools =>Serial Monitor to view serial output as shown in Figure 5-38.
Figure 5-38. Serial Monitor Output for I°C F-RAM Project

Example Projects

Write 16 bytes of data from data_bytes array (1, 2, 3, ...,16) to EXAMPLE_ADDR_2 (0x3456) address.
Read 15 bytes of data from EXAMPLE_ADDR_2 (0x3456) address through the random read function.

Read the sixteenth byte through the current read function.

Compare the written and read data and display the result (PASS/FAIL) on serial output.

COM20

F-REM I2C Example Project Start

1. Write Data
A3

2. Read Data

No. of bytes Read : 1
Data : AS

Write-Read : PASS

3. Write Data Array
1 2 3 4 5 a 7 8 g

4. Bead Data Array
1 2 3 4 5 [
Write-Read : FASS

F-REM I2C Example Project End

5.7.5 APIs

The API description is the same as for the PSoC 4 12C F-RAM. Refer to section 5.4.6
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A.1 CY15FRAMKIT-001 Schematics

Power selection

VDD 5V
= R1
ch) g 3 o VDD
T~

3v3 10UF ? J5 LED1, ,
1 R 220 Ohm
3 3 Power LED Green
3 Pin Header U

SP| F-RAM
VDD
VDD
s

: R3 R15 R4

4 7K 47k

U1 478 |, 3

CS# 1J 8 T~ T~
CS VDD
SO RIR_~ 30E 21 5% Do HOLDZ oAuF |1uF
WP# 3 N 6 SCK i
= wp SCK4—2 =
VSS Sl r
SPI F-RAM
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Appendix
12C F-RAM VDD
»
R7 R8
4.7k 4.7k
u2 cu cs
A0 1 8 :
Ej AQ VDD —— o
A1l 2 7 WP AT~ T~
A2 3 Q; SVE’:PU" 6 SCL 0.1 uF 1 uF
4 5 SDA
VSS SDA
12C F-RAM

12C F-RAM Device Select Address

SwWi1 VDD
A B R
A7 5B & K

3-POS DIP

By default, A0, Al, A2 are pulled down internally i
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Aopendix
(J1-J4) Arduino Compatible Headers
HOLD# RS 0E R
NO LOAD
J1 WP# _R§ 0E 1
T 1
3V3 BV 1 CS# 32
2 S R1 30E 4
32 55 RoAA s
g 4 SCK___RIT_~_~30E ? :
RESET 6 g 5 g
7 SDA__ R1Q . A30E 9
[ I 9
814 L SCL__RaQJIA30E 109
Bx1RECP 10x1 RECP
J2 s R 30E J4
NOTLOAD | 1l
1 2
21, SO R2Z s N30E] 32
SDA R9 30E 2 3 NO LOAD g A
R10 E |6 7
REEASS AP R A A0E 8 1s
6x1 RECP NO LOAD by
Debug Header i T
6 VDD NO LOAD NO LOAD
TP1 TP2 NO LOAD VDD
SO 1 1 2 2 C6 BLAC BLAC TP3
SCK 3 4o 1 w3
RESET 5 |2 g 6 P
° 0.1 uF
3X2 CONN FEMALE
NO LOAD < N
J7
=107, W N 5|2 SClL
CS# 3 4
— 3 4
2X2 CONN FEMALE
NO LOAD
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A.2 Pin Assignment Table

This section provides the pin map of the headers and their usage.
Arduino Compatible Headers (J1, J2, J3, J4)

Appendix

J1i
Pin Arduino Signal PSoC 4 Pioneer Kit Signals CY15FRSAi\3/InI;I|'IS'-001 .
Ji1 1 VIN VIN NC
J1 2 GND GND GND
J1_3 GND GND GND
J1 4 5V V5.0 5V
J1.5 3.3V V3.3 3v3
J1. 6 RESET# RESET# RESET#
J1.7 IOREF P4_VDD NC
Ji1_8 NC NC NC
J2
Pin Arduino Signals PSoC 4 Pioneer Kit Signals CYlSFRSAiQAnng'OOl i
J2. 1 A0 P2[0] NC
J2 2 Al P2[1] NC
J2_3 A2 P2[2] NC
J2_4 A3 P2[3] NC
J2.5 A4 [SDA (I°C) P2[4] SDA
J2_6 A5/SCL (I°C) P2[5] SCL
J3
Pin Arduino Signals PSoC 4 Pioneer Kit Signals CY15FRAMKIT-001 Kit Signals
J3 1 D8 P2[6] HOLD# (SPI F-RAM)
J3 2 D9 (PWM) P3[6] WP# (SPI F-RAM)
J3. 3 D10 (PWM/SS) P3[4] / CS (SCB1) CS# (SPI F-RAM)
J3 4 D11 (PWM/MOSI) |P3[0]/ MOSI (SCB1) S
J3 5 D12 (MISO) P3[1]/ MISO (SCB1) SO
J3 6 D13 (SCK) PO[6] / SCK (SCB1) SCK
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J3
Pin Arduino Signals PSoC 4 Pioneer Kit Signals CY15FRAMKIT-001 Kit Signals
J3 7 GND GND GND
J3.8 AREF P1[7] NC
J3 9 SDA P4[1] / SDA (SCBO) SDA
J3 10 SCL P4[0] / SCL (SCBO0) SCL
J4
Pin Arduino Signals PSoC 4 Pioneer Kit Signals CY15FRSAi3An|;||-IS-_001 ol
J4 1 DO (UART RX) PO[4] / SCL (SCB1) NC
J4 2 D1 (UART TX) PO[5] / SDA (SCB1) NC
J4 3 D2 PO[7] NC
J4 4 D3 (PWM) P3[7] NC
J4_5 D4 PO[0] NC
J4 6 D5 (PWM) P3[5] NC
J4 7 D6 (PWM) P1[0] NC
J4a 8 D7 P2[7] WP (I°C F-RAM)

A.3 Debug Header I/Os

J6
Pin Debug Signals
J6_1 SO
J6_2 VDD
J6_3 SCK
J6_4 Sl
J6_5 RESET#
J6_6 GND

J7
Pin Debug Signals
J7.1 SDA
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J7
Pin Debug Signals
J7.2 SCL
J7.3 CS#
J7 4 GND
A.4 Use of Zero-ohm Resistors and No Load
Unit Resistor Usage
SPI F-RAM Device R5 Solder zero-ohm resistor to control the SPI HOLD# pin
from the controller
SPI F-RAM Device R6 Solder zero-ohm resistor to control the SP1 WP# pin from
the controller
. 2 .
2C F-RAM Device R11 Solder zero-ohm resistor to control the 1°C WP pin from the
controller
A.5 Use of 30-ohm Resistors and No Load
Unit Resistor Usage
2C Communication R9 Solder a 30-ohm resistor to access the SDA for the I°C
communication in Arduino UNO R2 boards
2C Communication R10 Solder a 30-ohm resistor to access the SCL for the I°C
communication in Arduino UNO R2 boards
Solder a 30-ohm resistor to use J4_1 as SPI Sl pin. This
SPI Communication R21 will free the Sl on J3_4, which can be used for the
I°C-USB Bridge communication on the CY8CKIT-042
Pioneer Kit.
Solder a 30-ohm resistor to use J4_2 as SPI SO pin. This
SPI Communication R22 will free the SO on J3_5, which can be used for the
I°C-USB Bridge communication on the CY8CKIT-042
Pioneer Kit.
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A.6 Bill of Materials (BOM)

Appendix

No. | Qty Reference Value Description Manufacturer Mfr Part Number
PCB, 52.07mm X
53.59mm, 2 Layer,
Enig Finish, High Tg,
1 Blue color Solder Cypress
mask, white color
silkscreen
CAP TANT 10UF 10V .
2 1 C1 10 uF 20% 1206 AVX Corporation '(I)’PSA106M010R180
CAP CER 0.1UF 50V Murata GRM188R71C104K
3 3 €2,C4,C6 0.1uF Y5V 0603 Electronics A01D
CAP CERAMIC 1.0UF .
4 2 C3,C5 1uF 25\ X5R 0603 10% Taiyo Yuden TMK107BJ105KA-T
CONN RCPT .100"
5 2 J1,J4 8x1 RECP 8PS R/A SGL TIN Samtec Inc SSQ-108-03-T-S
CONN RCPT .100"
6 1 J2 6x1 RECP 6POS SNGL TIN Samtec Inc SSQ-106-03-T-S
CONN RCPT .100"
7 1 J3 10x1 RECP 10POS SNGL TIN Samtec Inc SSQ-110-03-T-S
3 Pin CONN HEADER
8 1 J5 VERT SGL 3POS 3M 961103-6404-AR
Header
GOLD
Power LED LED GREEN CLEAR Chicago
° 1 LED1 Green 0805 SMD Miniature CMD17-21VGC/TR8
RES 0.0 OHM 1/8W .
10 1 R1 OE JUMP 0805 SMD Panasonic - ECG | ERJ-6GEYORO0OV
RES 220 OHM 1/10W .
11 1 R2 220 Ohm 5% 0603 SMD Panasonic-ECG ERJ-3GEYJ221V
R3,R4,R7,R8,R1 RES 4.7K OHM 1/10W .
12 8 2 R13,R14, R15 4.7k 5% 0603 SMD Panasonic-ECG ERJ-3GEYJ472V
R16,R17,R18,R1 RES SMD 30 OHM 5% .
13 5 9 R20 30 ohm 1/10W 0603 Panasonic - ECG | ERJ-3GEYJ300V
SW DIP SLIDE SPST )
14 1 SW1i 3-POS DIP 3 POS UNSEALD E-Switch KAS1103E
TVS DIODE 5VWM Diodes
15 L TVS1 5V 350W 14.5VC SOD323 Incorporated SD05-7
IC FRAM 256-KBIT
16 1 Ul SPI F-RAM 40MHZ 8SOIC Cypress FM25W256-G
IC FRAM 256-KBIT
17 1 u2 12C F-RAM 3.AMHZ 8SOIC Cypress FM24W256-G
18 1 N/A Jumper Jumper 3M 969102-0000-DA
No Load Components
CONN HEADER
19 1 J6 3X2 CONN VERT DUAL 6POS 3M 961206-6404-AR
FEMALE
GOLD
CONN HEADER
20 |1 37 2X2 CONN | \/EpT DUAL 4POS 3M 961204-6404-AR
FEMALE
GOLD
RES 0.0 OHM 1/10W .
21 3 R5,R6,R11 OE 0603 SMD Panasonic - ECG | ERJ-3GEYJ302V
RES SMD 30 OHM 5% .
22 4 R9,R10,R21,R22 | 30E 1/10W 0603 Panasonic - ECG | ERJ-3GEYJ300V
TEST POINT PC MINI | Keystone
23 3 TP1,TP2,TP3 BLACK 040"D Black Electronics 5001
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No. | Qty |

Reference Value Description Manufacturer Mfr Part Number
Special Jumper Installation Instructions
!Srsr:agr Headers & Wire
24 |1 J5 jumper Housings 2.54MM 3M 969102-0000-DA
across pins SHUNT
land?2
Label
LBL, PCA Label,
Vendor Code,
Datecode, Serial Cypress
25 1 N/A N/A Number 121-60201-01 | Semiconductor
REV 01
(YYWWVVXXXXX)
LBL, CY15FRAMKIT- Cvoress
26 |1 N/A N/A 001 QR Code, 12mm ypr
Semiconductor
X 12mm
LBL, Anti-Static
Warning, ULINE PN S- Cvpress
27 |1 N/A N/A 6516, 5/8" x 2", ngnicon ductor
"Attention Observe
Precautions"
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